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An Introduction to Business Processes

Business Process Management (BPM) software is a powerful technology, enabling organisations to streamline

business systems through the automation of processes and communications across multiple systems, databases,

and people — leading to improvements in process efficiency across the whole business.

Incorporating workflow technology that enables human interaction at critical stages of a business process, BPM

software has a deserved reputation as one of the most valuable investments in IT that a company canmake.

Product Overview

BPA Platform is a unique Business Process Management (BPM) software suite, enabling organisations to build

powerful automated business processes, while leveraging the power of existing systems. The BPA Platform product

range offers a scalable, cost-effective automation solution for organisations, ranging from the small-to-medium

business to the large enterprise.

BPA Platform provides unrivalled functionality for the provision of BPM solutions. Its extensible process modelling

capabilities enable the automation of complex manual tasks, therefore driving improvements in operational

efficiency throughout the enterprise. It also provides a common automation framework across the entire information

chain.

The product is built around the central concepts of "tasks" and "steps" — providing the ability to build flexible

automation processes with logical building blocks. These processes integrate seamlessly with existing information

sources, applications, infrastructure, and communications without the need for complex programming.

BPA Platform Components

The diagram below demonstrates an example architecture of all main BPA Platform components:
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For more information about the various Agents detailed above, see About BPA Platform Agents.

BPA Platform Server

The BPA Platform server consists of the tasks' runtime engine and the configuration store (back-end database)

where all BPA Platform data and task information is held.

It is recommended you install the server on a dedicatedmachine. For a detailed description of the installation

procedure, refer to the product help.

Remote BPA PlatformClient

The BPA Platform client is the interface used to create andmanaged your tasks. This is installed locally to the BPA

Platform server, or can be installed in a remote location that has access back to the BPA Platform server.

Third-Party Connectors

As well as the standard tools made available with BPA Platform, third-party connectors are also available. These

connect BPA Platform to external applications and platforms, such as, CRM and ERP systems. For more information,

consult the white paper library.

System Architecture

BPA Platform is Windows-based software, using a true three-tier client server model over TCP/IP, with a multi-

threaded server running as a Windows service:

 The BPA Platform client — Provides all administrative and task design capabilities

 The BPA Platform server — Provides client connectivity andmanages task processing

 The BPA Platform data store — Contains BPA Platform data and task information

Three-tier architecture has a number of benefits:

 Data is kept independent to network conditions as it is managed centrally by the server

 Data integrity is maintained as database operations are transactional

 Improved security as clients do not need a network share to access data
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Task Performance and Processing

The BPA Platform server is multi-threaded, enabling multiple tasks to run simultaneously. This increases server

processing capacity and reduces the need for queuing tasks. The number of task threads is determined by Server

settings.

It also supports multi-processor functionality, andminimises processor context-switching.

Task Isolation

The BPA Platform server isolates a task instance from both the BPA Platform server itself and other task instances.

This means that external inconsistencies, such as exceptions caused by ODBC drivers, applications, or other system

APIs do not affect ongoing BPA Platform operations beyond that task instance. Such untoward occurrences are

logged immediately to the Event Log and, if configured, notifications are sent to the administrator and task "owner".

Operational Schematic

This diagram demonstrates how BPA Platform provides automated BPM services, and the main components

contributing to those services. It also demonstrates how BPA Platform provides greater efficiency by interacting with

business partners, individuals, and systems (whether internal or external).
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Tasks

Tasks are the primary entity in BPA Platform. They represent all, or a part of, a distinct business process, containing

multiple interrelated steps.

By building tasks, you can design business rules that partially or completely replace a manual process. Each task

provides complete control for which steps are used and in what sequence, using visual modelling techniques. A task

can be scheduled periodically or triggered real-time.

Task developers can also automatically run tasks through the BPA Platform API, or by integrating the WorkflowWeb

Service into their own applications.

Tools and Steps

Tools are used to create steps within a task, providing the functional building blocks that interface with common

technologies, systems, and applications. They are joined together in a logical sequence to build the business process.

The following tool categories are available:

Tool Category
Category

Icon
Description

Data Connectors Provides a connection between BPA Platform and an external data source,

such as, a relational database (RDBMS) or a CRM system, or even third

party applications used with BPA Platform.

Event Triggers a task to run based on specific criteria and exposes data through

variables to other steps in the task.

Execute Executes an external application, procedure or object, allowing developers

to control the precise result of this step when using proprietary systems.

Input Pulls information into BPA Platform from a source, such as a relational

database (RDBMS), file format, or other structured source, and exposes this

to other steps.

Format Consumes and formats data, then exposes that data in a designated form to

other steps.

General Provides generic functionality to BPA Platform tasks, such as, moving files.

Output Consumes information from Input or Format steps and outputs the

information from BPA Platform into another system, application, or

communicationmethod.

For more information about the tools available in each tool category, go to About BPA Platform Tools
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Installing BPA Platform

You use the same BPA Platform installation EXE to install the server, clients, and agents:

For a detailed description of how to use the Installation Console, refer to the product help.

Configuring BPA Platform

You use the BPA Platform Configurator to install third-party software that may be required by available tools.

Connections to required agents are also configured here. Note that you can only launch the Configurator if logged

into the machine with Administrator rights.
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Configurator Features

 The installation is not stopped if the prerequisites for a selected feature are not available as these are

checked by the Configurator

 Features can be configured immediately or left until required

 The Configurator launches automatically after installation is complete so you can start the configuration

immediately

 The Configurator provides a graphical indication of the configuration status of each feature

 After changes have beenmade, you can refresh the configuration details to update their status without

closing the application

 The configuration process can be saved, stopped and restarted at any time

 The Configurator can be launched at any time from either the Windows Startmenu or from inside the

Installation Console

Configurator Layout

The Configurator interface is split into two panes:
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 Navigation pane— The navigation pane uses a tree structure, with a folder node for each installed feature.

Greyed-out folders are for features not yet installed.

indicates that the feature has been configured and is usable

indicates that a configuration issue exists which must be rectified before that feature can be used

 Configuration pane—Displays configuration options for the feature highlighted in the navigation pane

Configuring BPA Platform Features

Features can be configured separately by selecting them in the navigation pane. Alternatively, you can step through

the configuration process in order by clicking Next as each configuration is completed. Only installed and available

features can be configured— the Configurator skips over the others.

About Feature Prerequisites

A Prerequisites node is available for each feature, as shown above.

Clicking on a Prerequisites node displays all that is needed for the related feature in the Configuration pane, where:

indicates those prerequisites are in place

indicates that a configuration issue exists but the feature is still usable

indicates the prerequisite has not beenmet

 Click to see a full description of the problem. If available, click or

to complete the prerequisite.

If required, you can complete the configuration at a later date without affecting other aspects of BPA

Platform, though the feature in question remains unusable.
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Navigating the BPA Platform Client

You use the BPA Platform client to maintain your BPA Platform installation including creating andmaintaining tasks,

running maintenance, and administering user permissions.

About the User Profile

Clicking the user profile's down arrow displays the following options:

 Change Password— Change the password of the currently logged in user — only visible to internal users;

Windows users cannot change their passwords through BPA Platform

 Switch User— Logs off the current user and returns you to the client login screen

 Exit— As above but instead closes the client completely

About the Toolbar

The client administration tools are grouped according to function (if all the toolbar is not seen, click to see the

hidden toolbars):

Managing Folders

We recommend you group your tasks into folders for easier management.
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Use the Folders toolbar to manage your task folders:

(New Folder) — Create a new folder in the highlighted node of the Tasks tree

(Move To Folder) — Moves the highlighted task to a new location

(Copy To Folder) — Copies the highlighted task to a new location

Managing Task Processing

Use the Tasks toolbar to manage task run-time: Use:

(New Task) to create a task in the folder currently open in Tasks.

(Queue Now) and (Terminate Task) to manually start and stop tasks.

(Event Log) to open the full Log so may take some time to open. To view entries for a specific task, either

open the Event Log and filter the entries or right-click the task itself and select Event Log.

(Import) to bring in existing tasks and their corresponding global connections and objects from another BPA

Platform instance.

(Export) to save tasks and their corresponding global connections and objects from this BPA Platform

instance.

Managing Tasks

Use the Edit toolbar to manage existing tasks:

Open Rename Cut Copy Paste Delete Add
Shortcut

Managing Your BPA Platform Installation

Use Administration to manage this BPA Platform instance:

(New User) — Create a new user.
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(Licensing) — Coming Soon!

(Settings) — Coming Soon!

(Maintenance) — Coming Soon!

(Help) — Takes you to this page.

(About) — Lists the version and build number of your BPA Platform installation. Use this to also view

information about the hardware hosting this instance of BPA Platform (use (System Info))

Using Shortcuts

You can add any frequently edited variables, tasks, tools (global configuration only) to the Shortcuts panel on the left.

Right-click on the required item and select Add to Shortcut Bar.

You can also group your shortcuts according to any category you want. Right-click in the shortcut pane and select

Add new group. Drag relevant items to the new group. You can rename the group by right-clicking the group

header.

About the Resources Tree

The resources tree makes available those global settings and tasks that make up your BPA Platform installation.

(System) — Resources found under this node are only available to System Administrator-level users

(Users) — Manage BPA Platform user accounts

(Variables) — Manage all global variables; task variables are managed in the task itself

(Formulas) — Manage all global formulas; task formulas are managed in the task itself

(Functions) — Manage all global functions; task functions are managed in the task itself

(Tools) — Manage the global connections for available BPA Platform tools
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(Memory Providers) — Manage the global connections for available memory providers

(Agents) — Displays the registered Agents

(Tasks) — All created tasks and task folders are "stored" in this node

About the Items List

The items list shows the contents of the selected resource node.

About Active Tasks

The Active Tasks pane provides a visual representation of real-time task run-time:

 The top pane provides the status of the current task running

 The bottom pane showing the status of the steps in the task

If multiple tasks are running at the same time, the bottom pane shows the steps for the currently highlighted task in

the top pane.
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Setting BPA Platform Global Options

The global options affect all aspects of BPA Platform, especially all task run-times.

About the Server Tab

The Server tab of the Options interface allows a system administrator to configure how the BPA Platform server

"listens" for connections from BPA Platform clients. It also determines howmany tasks may be run asynchronously

on the server.
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About the Impersonation Tab

Impersonation is where the BPA Platform server "impersonates" a Windows domain user, enabling it to access

remote network locations, such as databases, files, or printers.

Why is this needed? Tasks are run using the Windows Local System account. This account typically does not have

sufficient network access rights for such resources, resulting in failed tasks. By impersonation a valid Windows

domain user, such remote resources are available to the task. Note that this only applies at task run-time; if you are

logged into the BPA Platform client as a Windows domain user, or even the computer hosting BPA Platform itself, this

makes no difference to the account used by running tasks.

Two types of impersonation exist:

 Global — Applies impersonation to all tasks

 Task— Applies impersonation to a single task

Where global- and task-level impersonation exists in the same BPA Platform installation, task-level impersonation

overrides global.

The Impersonation tab is used to run all tasks under a specific domain users’ credentials.

NOTE: It is only possible to browse and select Windows users if the machine being used is logged onto the

domain and has access to Active Directory.
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About the Run Times and Maintenance Tab

The Run Times and Maintenance tab is used to globally set times when tasks andmaintenance routines should

run. This ensures tasks do not conflict with other automated processes such as backup or data warehousing routines.

NOTE: It is also possible to customise the run-times at task level. However, the task must respect the global

settings set in this tab.

To manage instances where tasks are running when the maintenance is scheduled to start, use the following

parameter to set a time period to delay maintenance being run:

 Force maintenance initialisation timeout

NOTE:Maintenance starts immediately after this time period has expired, irrespective of whether tasks are

currently running. Tasks already in progress are allowed to complete, however no new task runs can be started

until maintenance has completed.
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About the National Holidays Tab

The National Holidays tab is used to set dates when tasks are not to be run. To enable a list of dates to be quickly

compiled, an import feature is provided through which a pre-configured list of dates for a specific country may be

automatically added. Alternatively, dates may be individually added and then edited or removed as required.
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About the Event Log Tab

The Event Log tab provides a system administrator with the facility to set a global time interval in days after which

event log entries are purged.

Optionally a user-defined PowerShell script can be linked to the process which will run prior to the purging of the log.

This can be used to save the log data to disk, for example.
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About the Notifications Tab

This feature provides the facility to set up automatic notifications by email to system administrators and task owners

when selected warnings and errors occur within BPA Platform.

An administrator can configure exactly what notifications are required for the different types of potential

occurrences. Administrators and task owners are alerted when an error occurs so that they can assess the situation

and take remedial action if required.
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Creating and Managing BPA Platform Tasks

This section describes the various features and interfaces of the BPA Platform client to help you create andmanage

tasks.

Using the Task Interface

The task interface is the main interface you create tasks with. Only users who have a Task Administrator Server

Role can create, edit, or run tasks — see About the Server Roles Tab.

You create new tasks by either:

 Clicking New Task.

 Right-clicking on Tasks or a child folder and selecting New Task

If a task folder structure is in place, you can either create the task directly in the relevant folder or in the

parent Tasks folder andmove it after creation— users must have Edit permissions for that folder.

About theGeneral Tab

Use the General tab to name your task and set any run-time parameters, such as, debug, impersonation, and task

holiday time.

Enter a meaningful Name for this task. If required, add a Description to help other users identify the task.

The Version number is incremented every time the task is edited and saved. You should not need to adjust this value

but if you do, use the same number format.
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To set impersonation, task holiday times, and other advanced features, click (Options) — see About the Task

Options Interface.

All tasks are enabled by default. Use the slider to prevent the task from running.

About theDesign Tab

Use the Design tab to create new or edit existing tasks.

Task View or Step Summary

By default, the Design tab opens to the full task design area where you add task steps from the Task Browser on the

right.
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If any task steps are highlighted, you can select Step Summary to view the generic details of that step (these are

taken from the General tab):

If required, you can rename the task step and amend the description from here. Additionally, if the tool requires any

global connections or configurations you can access them from the Step Summary view— click (Global

configuration).

Aligning Task Steps

To move multiple task steps, click and hold to draw a box around the required steps. With multiple task steps

selected, you can also use the following to align your task steps:

— Align the steps to the same horizontal line

— Align the steps to the same vertical line

— Evenly space the steps out along the horizontal line

— Evenly space the steps out along the vertical line

Note that the above buttons are only active when two or more steps are selected.

Use (Fit) to fit all task steps to the current design view pane.
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About Start and End Steps

For each task there is a Start step, denoted by above the step, and an End step denoted by above the

task step. Both steps can be automatically selected by the tasks or can be assignedmanually — right-click in the

design area and click Automatically Choose Start Step to toggle between selected and not.

A task may have more than one start step— If an Event tool is used to trigger the task to run, typically this and the

immediately following step are both denoted as the start. This is because the Event step triggers the task to run but

the actual "job" of the task is started by another step.

A task may also have more than one end step— If a Decision step has been added to the task, each branch would

have its own end step.

About the Task Browser

The Task Browser holds all tools and properties needed to create tasks — recordsets, variables, functions, formulas,

and step properties as well as available BPA Platform tools. It is available as part of the Design tab and again when

configuring each task step.

About the Tools Tab

The Tools tab exposes all available BPA Platform tools used to create task steps. Note that this tab is only available

with the Task Browser in the Design tab. Use Scope to only view tools in the specified category.
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About the Environment Tab

The Environment tab exposes all available task data that can be used by this task step— other step's data such as

recordsets, variables, formulas, functions, and step properties.

Additionally, task-specific variables, formulas, and functions can be created here — right-click on the required item

and selectNew.
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About the Reference Tab

The Reference tab exposes several common Visual Basic scripts which can be used in task steps — drag-and-drop

the script into a text area in the step configuration interface.

About the Help Tab

The Help tab displays help for that tool or tab that is currently active.
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About the Script Tab

The Script tab displays the actual VBScript used to run the task.

Use Edit to adjust the script as required; however, it is not recommended you so unless instructed by a Codeless

Platforms partner as you cannot use the Design tab again after changing to scripting mode.

About the Task Options Interface

Task Options allow you to control when and how a specific task is run. These include:

 Setting valid run times — see About the Run Times Tab and About the National Holidays Tab

 Setting the user that runs the task— see About the Impersonation Tab

 Setting task disable, time-out, and concurrent instance rules — see About the Advanced Tab

You open the Task Options interface by clicking (Options) in the task design's General tab.
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About the Run Times Tab

Use the Run Times tab to specify the times of the day and days of the week when the task can run.

Each time block represents 30 minutes; each day has 48 blocks. Green blocks indicate allowed task run time, with

white blocks indicating the times when the task cannot run. Those blocks containing a spanner indicate when

maintenance is scheduled to run on the BPA Platform server. By default, tasks do not run while maintenance is being

run. If a task is triggered to run during this time, whether automatically or manually, run-time is delayed until

maintenance has completed, whatever time that is. Note that maintenance run-times are set globally and cannot be

overridden for individual tasks — see About the Run Times andMaintenance Tab.

To select / clear a timeslot, click the relevant box.

To select / clear the same timeslot for all days, click the relevant oval box at the top of the grid.

To select / clear a whole day, click the relevant label.

Click and hold to select multiple consecutive timeslots.
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About theNational Holidays Tab

Use the National Holidays tab to specify which public holidays this task does not run on. At the time of writing, you

cannot specify the actual date; instead, youmust choose which group of holiday to use.

Holiday groups must be added first. You do this in BPA Platform's global options — see About the National Holidays

Tab.
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About the Impersonation Tab

Impersonation is where the BPA Platform server "impersonates" a Windows domain user, enabling it to access

remote network locations, such as databases, files, or printers.

Why is this needed? Tasks are run using the Windows Local System account. This account typically does not have

sufficient network access rights for such resources, resulting in failed tasks. By impersonation a valid Windows

domain user, such remote resources are available to the task. Note that this only applies at task run-time; if you are

logged into the BPA Platform client as a Windows domain user, or even the computer hosting BPA Platform itself, this

makes no difference to the account used by running tasks.

Two types of impersonation exist:

 Global — Applies impersonation to all tasks

 Task— Applies impersonation to a single task

Where global- and task-level impersonation exists in the same BPA Platform installation, task-level impersonation

overrides global.

Use the Impersonation tab to set the impersonated user for this task only.

NOTE: Only Windows users can be selected as impersonation users; youmust ensure the machine hosting this

instance of BPA Platform is logged into the same domain and has access to Active Directory.
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About the Advanced Tab

Use the Advanced tab to handle automatic disabling of tasks, debug entries, and other such advanced features.

Debugging a Task

From time-to-time, our Support Desk may require extra information from a task run to help diagnose a problem.

Select Enable Debug to log extra information to the Event Log. Youmust ensure you clear the selection when no

longer needed as it creates long, verbose entries in the Log which can take up valuable database space.
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Running Tasks Concurrently

If a task is queued to runmultiple times in the same time period, whether by being manually run or via a trigger

event, it must wait for the original task run to complete before the next one starts by default. If required, you can

have the task instances run concurrently. From theMaximum Concurrent Instances pane, select one of the

following:

 Multiple Instances— Specify the number of task instances that can occur at the same time

 Unlimited Instances— There is no limit to the number of task instances that can occur at the same time

Automatically Disabling Tasks

If required, you can have a task disable itself when it fails to run after a specific number of times for whatever reason.

From the Automatic Disabling pane, enable Auto-disable Task on a number of consecutive failures and specify

the number below.

Setting Task Time-Outs

From time-to-time, a task may continually process rather than completing; this can take up processing resources. To

prevent such scenarios occurring, from the Task Timeout pane enable Kill task after and specify the number of

Day(s), Hour(s),Minute(s), or Second(s) the task can run for before being terminated.

Using Task Folders

We recommend you group your tasks into folders for easier management. Note that there is no limit for the level of

sub-folders you can create.
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Setting Permissions for Task Folders

If required, you can set permissions for user access to the task folder.

New users are given full access:

 Full Control—Users can create sub-folders and tasks, and remove the same from this folder

 Visible— The folder and its contents are displayed to the user when clicked

 Create Folder—Users can create new sub-folders in this folder

 Create—User can create tasks in this folder

 Read—Users can only read tasks in this folder

 Execute—Users canmanually run (all) tasks in this folder (right-click the task and selectQueue Now)

 Edit Own—Users can only edit those tasks and sub-folders they have created in this folder

 Edit All—Users can edit any task or sub-folder created in this folder

 Delete Own—Users can only delete tasks and sub-folder they have created in this folder

 Delete All—Users can delete any task or sub-folder created in this folder

About BPA Platform Tools

Tools are used to create steps in a task, which are then linked together to form the "task plan". Steps expose and

consume information each other in different ways depending on their specific purpose.

The following BPA Platform tools are available to you to create tasks (note that some tools appear in multiple tool

categories):

Icon Tool Name Tool Category

Applications Platform Connector Data Connectors

Call COM Object Execute
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Icon Tool Name Tool Category

Call Stored Procedure (OLEDB) Input, Data Connectors, Output, and Execute

Call Task Execute

Convert Recordset to XML Format

Convert XML to Recordset Format

Create Workflow Job Format

Database Query (ODBC) Input and Data Connectors

Database Query (OLEDB) Input and Data Connectors

Decision General

Email Trigger (SMTP) Event

File Management General

Filter Data General

Format as Flat File Format

Format as HTML Format

Format as HTML Pro Format
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Icon Tool Name Tool Category

Format as Text Format

Import Flat File Input

Import XML Document Input

Microsoft SQL Server Trigger Event

Oracle Trigger Event

Parse Text General

Print Document Output

Retrieve Text Message Input

Run Crystal Report Format

Run External Program Execute

RunMicrosoft Reporting Services Format

RunMicrosoft Word (Merge) Format

Run VBScript Execute

Save File Output
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Icon Tool Name Tool Category

Schedule Event

Send Email (SMTP) Output

Send Fax (Tobit) Output

Send Text Message Output

Transfer File (FTP) Output

Transform Data Format

Web Service Connector Data Connectors

Workflow Job Trigger Event

Each tool's white paper is available to download from

https://www.codelessplatforms.com/community/resources/white-paper-library/.
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About BPA Platform Agents

BPA Platform agents are a distributed component residing on another machine. Agents monitor for occurrences of

an event for a particular process. When such an event is identified, the agent notifies the BPA Platform server to

queue the relevant task(s). Related data can also be passed to the server for the tasks.

Agent Description

Email

Trigger

(SMTP)

Agent

The Email Trigger (SMTP) Agent works with the Email Trigger (SMTP) tool to process incoming SMTP

messages. It can run on the same or separate computer to the server. It launches tasks when

messages arrive that match filter rules previously configured within a Email Trigger (SMTP) step for a

task.

It interfaces with Microsoft Virtual SMTP Server which is part of the Microsoft Internet Information

Services. When a message is received by the Virtual SMTP Server, a copy of the message is passed to

the Agent which in turn decides if there are any tasks to run.

Microsoft

SQL

Server

Trigger

Agent

The Microsoft SQL Server Trigger Agent is a service that sits between BPA Platform and SQL Server. It

is installed onto any SQL Server instance and is responsible for both maintaining the triggers in SQL

Server and for handling the running of a task once a trigger has been fired.

When a SQL Server trigger is fired, a connection is made to the Agent service which then launches the

relevant task.

BPA Platform also supports the use of triggers on a SQL Server failover cluster, enabling the firing of

triggered tasks from whichever server in the cluster is active at the time. An Agent must be installed on

each node, starting with the active node. However, because all are monitoring the same SQL Server

instance, the BPA Platform client sees only a single Agent registration.

Oracle

Trigger

Agent

The Oracle Trigger Agent is a service that sits between BPA Platform and an Oracle server. It can be

installed onto any Oracle Server. It is responsible for both maintaining the triggers in Oracle Server,

and for handling the running of a task once a trigger has been fired.

When an Oracle trigger is fired, a connection is made to the agent service which then launches the

applicable task.

Schedule

Agent

The Schedule Agent is a service that resides on the BPA Platform server (BPA Platform Schedule

Agent) and, unlike the other agents, is automatically included in the server installation. The agent is

responsible for both maintaining task schedules and for handling the running of tasks at the scheduled

date and time. When a schedule is reached the agent service launches the applicable task.

Workflow

Job

Trigger

Agent

The Workflow Job Trigger Agent is a Windows service which resides on one or a number of Web Server

computers. It connects to andmonitors all configured Create Workflow Job andWorkflow Job Trigger

steps on its associated BPA Platform server. These are retrieved and cached locally.

The Workflow Job Trigger Agent checks the IIS server and verifies that the currently configured folders

can handle Workflow Jobs if requested.
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About BPA Platform Variables

Variables are created and used extensively throughout BPA Platform and can either have fixed values or values that

are dynamically populated when a task is run.

Two classes of variable can be created.

About Global Variables

Global variables are available for all tasks in this BPA Platform installation. Only users with System Administrator or

Variable Administrator rights can create global variables. However, once created, global variables can be used by

any task.
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About Task Variables

Task variables are only available for the specific task they are created for. Users with Task Administrator rights can

create task variables.

When exporting tasks, task variables are automatically included.
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About BPA Platform Formulas

Formulas are VBScript expressions that return a value taken from outside BPA Platform, such as a date or

timestamp.

Two classes of formula can be created.

About Global Formulas

Global formulas are available for all tasks in this BPA Platform installation. Only users with System Administrator or

Formula Administrator rights can create global formulas. However, once created, global formulas can be used by

any task.

About Task Formulas

Task formulas are only available for the specific task they are created for. Users with Task Administrator rights can

create task formulas.

When exporting tasks, task formulas are automatically included.
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About BPA Platform Functions

Functions execute a series of VBScript statements that return a value.
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Two classes of function can be created.

About Global Functions

Global functions are available for all tasks in this BPA Platform installation. Only users with System Administrator or

Function Administrator rights can create global functions. However, once created, global variables can be used by

any task.

About Task Functions

Task functions are only available for the specific task they are created for. Users with Task Administrator rights can

create task functions.

When exporting tasks, task functions are automatically included.

About Repositories

Repositories are used by the Internal Memory feature to store memorised data in BPA Platform's proprietary

database format.

You can edit the repository's data and schema independently of the task that creates them.

You can also create repositories independent of a task which can then be used by multiple tasks.
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Example Use Cases

The following are just a few examples of how exposing memorised data in a Repository can be used:

 A Repository can be exported and imported as a .xml file which retains all Repository information, including

the hierarchical data structure.

 Repository data and schema information can be exported or imported as a .csv file.

 A Repository can be selected for use in any task so that different columns are populated from different data

sources.

 Repository data values can be manually edited, rows deleted or the Repository "reset" by deleting all the data.

 The Repository schema can be edited to change column details, insert or delete columns to match the data

source, and even insert child rows in the schema to create a hierarchical data structure.

 Using a Filter Data step, the current Repository data for a task can be compared to a new recordset produced

at task run-time to filter the data passed to the Output step for processing. A Repository search allows rows in

a selected schema to be returned and displayed.

 An advanced Repository search enables single or multiple search expressions to be constructed.

About Memory Definitions

Memory is used to store specific task data, such as recordset data, variables, and formulas. You use memory

definitions to ensure tasks only run when certain conditions have beenmet based on the memorised data. For

example, where customer credit limit notifications are stored in memory, you can have the Send Email (SMTP) step

check the memorised data to ensure the notification is not resent to the same customer.

Users must have permission to useMemory Definitions.
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You can create any number of memory definitions.

The following memory definition types are available:

About Internal Memory

The Internal Memory feature uses a Repository to memorise task data, by mapping fields from the recordset against

Repository fields.

Features include:

 The current Repository data for a task may be compared to a new recordset produced at task run-time to

filter the data passed to the Output Step for processing

 Repository data can be exported as XML or CSV for backup purposes or use in other applications

 Previously exported XML files can be imported into BPA Platform

 Previously exported or new CSV files can be imported into BPA Platform

 A Repository may be selected for use in any task so that different columns may be populated from different

data sources

 Repository data values can be edited, rows deleted, or the Repository "reset" by deleting all the data
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 The Repository schema may be edited to change column details, insert columns or delete columns to match

the data source

About ODBCMemory

You use the ODBC memory feature to create a definition that memorises data for a selected table, columns, or both,

from a specified ODBC data source at task run-time. Instead of mapping the data into a Repository, the data is

written back into the applicable table.

Features include:

 Memorise data using an compliant data source

 Transaction support

 Memorise based on rules created in VBScript
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About OLEDB Memory

You use the OLEDB memory feature to create a definition that memorises data for a selected table, columns, or both,

from a specified OLEDB data source at task run-time. Instead of mapping the data into a Repository, the data is

written back into the applicable table.

Features include:

 Memorise data using an compliant data source

 Transaction support

 Memorise based on rules created in VBScript

43 of 67



About Call Stored ProcedureMemory

You use the Call Stored Procedure memory feature to create a definition that memorises data for a selected table,

columns, or both, from a specified OLEDB data source by executing a stored procedure at task run-time. Instead of

mapping the data into a Repository, the data is written back into the applicable table. The stored procedure is

responsible for storing the parameters in the required format.

Transaction options allow a procedure execution to only be committed when criteria has beenmet, such as a

successful or failed iteration, or based on a rule.

Features include:

 Memorise data using an compliant data source

 Transaction support

 Memorise based on rules created in VBScript
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About Running Tasks

You create new tasks by either:

 Clicking New Task.

 Right-clicking on Tasks or a child folder and selecting New Task

If a task folder structure is in place, you can either create the task directly in the relevant folder or in the

parent Tasks folder andmove it after creation— users must have Edit permissions for that folder.

The task interface opens.

To run a task manually, you do the following:

1. Log into BPA Platform.

2. From the resources tree, expand the Tasks folder structure and locate the relevant task.

3. From the items list (right), right-click on the required task, and selectQueue Now.

If required, you can select more than one task (hold down CTRL and select each task in turn) and queue them at the

same time.

Alternatively, you can use the following methods to automatically run a task:

 Use the Schedule tool to execute tasks at a specific date and time or on a regular schedule

 Use other Event tools to trigger a task to run

For a detailed description of how to create a task, see How to Create a Basic Task.

Task Practises to Avoid

The following recommendations are made about task practises to avoid:

 Do not create tasks that contain multiple Event steps (see Tools and Steps) that initiate different parts of the

task flow.

 Do not create tasks that contain multiple unconnected task flows.

 Do not create tasks that daisy-chain unrelated activities from a single event, such as a single Schedule step

initiating tasks involving unrelated information, people, or systems.

 Do not create looping tasks, where there is no explicit endpoint. Tasks must have a definitive start and

endpoint for a single process flow.
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Exporting Tasks and Task Data

You can export your BPA Platform data for use in other BPA Platform installations. BPA Platform files have a .TKS or

.CONNECTION file extension. .TKSS files are locked BPA Platform solutions — refer to your Codeless Platforms

partner.

Click (Export) in the Tasks toolbar to create the files.

What Can Be ?

NOTE:User accounts and Agent configurations (Microsoft SQL Server Trigger Agent, Email Trigger (SMTP)

Agent, andWorkflow Job Trigger Agent) are not included in the tasks or connection files.

46 of 67



Objects Included in the .TKS File

 Task folders and contents

Sub-folders are automatically included when the parent folder is selected. If sub-folders are not required, you

can clear the selection before exporting.

 Tasks and associated properties

Associated task data is included when a task is exported, that is, task variables, task formulas, task functions,

memory definitions, and repositories as well as the task process itself.

 Repositories

Note that repositories can be separately exported through the Repository interface (see Exporting the

Repository Data Set). This method creates an .XML or .CSV file instead.

 Global formulas

 Global functions

 Global variables

Objects Included in a .CONNECTION File

 Any global connection or configuration created in your BPA Platform instance

NOTE:When exporting the global configuration for the Call Task tool, any users created specifically for

this tool are not included in the export. These must be recreatedmanually in the new BPA Platform

instance before importing the .CONNECTION file.

Importing Tasks and Task Data

Exported BPA Platform data can be imported into any BPA Platform instance running the same or higher version than

it was created in. This feature is particularly useful where a sandbox environment is used for testing purposes before

going live. Exported BPA Platform files have a .TKS or .CONNECTION file extension. .TKSS files are locked BPA

Platform solutions — refer to your Codeless Platforms partner.

To import a BPA Platform file, do one of the following:

 Click (Import) in the Tasks toolbar to load the files into BPA Platform
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 Right-click on any folder in the top-level Tasks folder and select Import— if doing this method when

importing the tasks file, be aware that

If any object in the tasks or connection file already exists in the BPA Platform instance, you are prompted for which

action to take (Replace, Do Nothing, or Create New— this appends (1) to the object name after import):

About BPA Platform User Accounts

During initial installation, only the Administrator account is created (which cannot be removed). This account has full

access to all BPA Platform features.From then on, any account with System Administrator or Security

Administrator enabled can create, edit, or delete BPA Platform user accounts.
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About the General Tab

Use the General tab to enter the credentials for this user account:

BPA Platform supports two types of user authentication:

 Internal— Internal accounts are created in and for BPA Platform only.

 Windows—Windows accounts are initially created in your Microsoft
®
Active Directory

®
database. To allow

your users to use their Windows credentials to access BPA Platform, youmust add those credentials to BPA

Platform as well.

If you need to disable an existing user account or create an inactive one, for pending users for example, use the

Disable Account / Enable Account slider to switch between the two.
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Creating a Local BPA PlatformAccount

To create a local BPA Platform account, configure the following:

 User name— Provide a unique username. All alphanumeric characters are supported.

 Email address—Optional. An email address is only required if this user is to receive server notifications and

alerts (see About the Notifications Tab).

 Authentication— Enable BPA Platform Authentication.

 Password— Enter a password that adheres to your organisation's security policies. Confirm the password.

Creating aWindows BPA PlatformAccount

 User name— Click Browse to select the Windows account.

 Email address—Optional. An email address is only required if this user is to receive server notifications and

alerts (see About the Notifications Tab).

 Authentication— EnableWindows Authentication.

 Domain— If the Windows user account is in a different domain to where the BPA Platform server is located,

enter the domain here.
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About the Server Roles Tab

Server roles determine which features of BPA Platform a user has access to. There are nine server roles you can

assign to a user:

Note that selecting System Administrator selects all other roles.
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NOTE: All user roles can access the Event Log.

Server Role Feature Access

System

Administrator

This is the highest level of server role.

System administrators have access to all features listed below.

Security

Administrator

Security administrators create BPA Platform users.

Note that only System administrator-level users canmaintain existing user accounts.

Server

Administrator

Server administrators maintain BPA Platform, including:

 Managing licences

 Managing server global options

 Running maintenance

Tool

Administrator

Create andmaintain global configuration for allowed tools (Tool Access tab), memory providers

(Memory Access tab), and agents (Tool Access tab).

Repository

Administrators

Create andmaintain repositories.

Variable

Administrator

Variable Administrators create andmaintain global variables.

Task-level variables are only available if users are Task Administrators as well.

Formula

Administrator

Formula Administrators create andmaintain global formulas.

Task-level formulas are only available if users are Task Administrators as well.

Function

Administrator

Function Administrators create andmaintain global functions.

Task-level functions are only available if users are Task Administrators as well.

Task

Administrator

When logged in, Task Administrators only have access to the top-level Tasks folder. From here,

they can:

 Create andmaintain tasks containing allowed tools

 Open tasks created by other users — note that if access to a tool has not been granted to

the logged in Task Administrator, steps using those tools cannot be opened

 Run tasks created by themselves and other users

 Enable / disable tasks owned by themselves and other users

 Create andmaintain task folders

 Maintain folders created by other users that they have been granted permission to view

 Create andmaintain task-level variables, functions, and formulas
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About the Tool Access Tab

Use the Tool Access tab to specify which BPA Platform tool's global configuration this Task or Tool Administrator can

access.

By default, all installed tools are available to all Task and Tool Administrators — clear the selection for those tools

you don't want the user to access.

Advanced Database Tool Settings

For those tools that provide connections to external databases (Database Query (ODBC), Database Query (OLEDB),

and Call Stored Procedure (OLEDB)), you can further customise user access. You do this by only allowing access to

specific global connections created for that tool. If the tool has multiple connections created, (Advanced) is

active.
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Click — all global connections created for that tool are displayed.

Clear the selection for those connections the user cannot access.

If your security policies dictate that this user must use different credentials to access the database, click Edit.

Provide the new credentials. Use Test to ensure the database can be reached.
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About the Memory Access Tab

Use theMemory Access tab to dictate which memory provider's global configuration this user can access.

Only users who are Tool Administrators can access memory definitions.

For more information about using the memory feature, refer to the product help.
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About the Script Objects Tab

The underlying language used to build the tasks is VBScript — go to the Script tab of an open task to view this. This

script can be edited to tailor the task to further meet your organisational needs.

Use the Script tab to allow or prevent users from editing the VBScript.
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Using the Event Log

The Event Log provides complete accountability for all activity in BPA Platform, such as:

 BPA Platform server events

 Enabling / disabling of tasks

 Task creation

 Task errors

 Task run-time events

 User activity

Click to open the Event Log.

Double-click an entry to view the full details.
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Filtering and Sorting the Event Log

You can also filter and sort the Event Log view as required— click for the required column, for example, the

Type column filter displays as
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If available, use the checkboxes to filter the event view or clickNumber Filters or Text Filters to add filter

expressions:

Exporting the Event Log

If required, you can export the Event Log to a CSV file — click .

NOTE: Even if a filter has been applied to your Event Log view, all available records since the last Event Log

purge (see About the Run Times andMaintenance Tab) are exported.
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About myBPAPlatform

myBPAPlatform is an ASP.NET web application which can be optionally installed onto any available Web Server.

WhenWorkflow Jobs are created, each one is assigned to a specific User, Users or User Groups for completion and

stored on a Web Server. There are then twomethods by which they can be made available to the specific user(s) for

actioning.

The first method is through the delivery to the user(s) of a hyperlink to the Workflow Job web form URL and this is

nominally contained within an email message. When the user clicks on the link the Workflow Job web form will open in

a web browser. The only drawback of this method is that users cannot see all of the Workflow Jobs that have been

assigned to them.

The secondmethod is to utilise myBPAPlatform. This is a fully featured web application that provides users with a

secure login method and through a comprehensive user interface allows users to manage all WorkFlow Jobs

assigned to them.

NOTE:

 myBPAPlatform requires IIS to have permission to use .NET service extensions. On IIS6, this can be set by

running IIS Manager > Web Service Extensions and setting the ASP.NET v4 extension to Allow.

 On IIS7 and later, if the .NET v4 framework was already installed when the ASP.NET role service was

added to the Web Service Role (using Server Manager > Roles > Add Role Services), then the .NET service

extensions should already be enabled. If not, then the .NET service extensions can be enabled by running

%WINDIR%\Microsoft.NET\Framework\(.net framework version)\aspnet_regiis.exe -i.

 After logging into myBPAPlatform the date / time settings displayed in the language bar will depend on

the language selected in the internet browser options.
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Logging Into myBPAPlatform

In order to use the myBPAPlatform web application youmust first log in through the Login page. Specific account

information is set by the Administrator when your account is created.

NOTE: The encryption option is very basic and is intended to be a simple password rather than proper

encryption. If this is required then SSL should be used.
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About the Main Interface

The main application interface is split into three basic areas:

 Title Bar— The Title Bar is located underneath the myBPAPlatform banner. It displays the name of the

currently logged in user, and provides links to the Codeless Platforms website, the help for the current page,

and log out button.

 Command Area— The Command Area provides access to various functions and features:

 New— Add a new workflow job

 Open—Opens the highlighted workflow job for editing

 Delete—Deletes the highlighted workflow job

 Look for— Enter search criteria when searching for workflow jobs

 Search In— Choose the type of search criteria: Created, Name,Modified, Owner, Stage

 Display Area— The Display Area displays all workflow jobs assigned to the logged in user:

 ID— The unique ID number for the workflow job

 Created— The date and time the job was created

 Name— The name of the job

 Modified— The date and time the job was modified

 Owner— The name of the user who is assigned ownership of the job at its current Stage

 Stage— The current stage for the job
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Adding New Workflow Jobs

Clicking on the Add button in the Command Bar displays the Add New Job page:

 Display Area - When the Add New Job page is being displayed, the following are provided in the Display Area:

 Select Job to Create— Provides a list of the Workflow Job Step types available to the user.

 Job Name— A name for the new Jobmay be manually entered.

 Add Job— Creates a single Workflow Job for the type selected with default values. The page will be

closed and the newWorkflow Job added to the list in the Overview page.
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Editing Workflow Jobs

Selecting a Workflow Job in the Overview page and then clicking on the Open button in the Command Bar displays

the Edit Job page:

 Display Area—When the Edit Job page is being displayed, the Workflow Job page is displayed andmay be

edited as required. Once editing is complete the changes may be saved by clicking on the Save button in the

Command Bar. In addition the following buttons are provided by default in all Workflow Job forms:

 Save— Saves the Workflow Job in its current state and closes the page. the Overview page will be

displayed.

 Submit— Publishes the Workflow Job form to the BPA Platform server. The Workflow Job form field

values are then compared against filters created for Workflow Job Submission Steps and where they

match tEhe applicable Task will be run. The page closes and the Overview page will be displayed.
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About BPA Platform Developer Modules

The following modules allow you to develop custom applications that expand your organisation's installation of BPA

Platform.

About the BPA Platform Task API

The BPA Platform API offers a structured, powerful and easy-to-use interface to access the BPA Platform Software

Suite’s server. It provides the ability to import tasks, enumerate tasks in folders, access basic task information,

enable / disable a task, set / read task variables, set / read task categories, set / read task run parameters, and to run

a task.

The API itself is COM-based and can therefore be used by any development environment supporting COM ,such as,

Microsoft Visual Basic, Microsoft Visual C++, ASP, or VBScript and so on.

About the BPA Platform Tool SDK

What is the Tool SDK?

BPA Platform is designed to model business processes by passing information between a number of different steps

each performing a specific task. The task carried out by each step is performed by a tool. BPA Platform comes with a

wide range of tools built in which can be dragged onto the task design surface and connected in an almost infinite

number of ways. However, it may be necessary to perform a function which BPA Platform does not include in the

standard package. To easily facilitate this, Codeless Platforms have developed the Tool SDK.

The Tool SDK is a bolt-in pack for Microsoft Visual Studio, allowing custom tools to be developed in C# or VB. This is

done by way of step-by-step wizards to simplify the process. The tools that are built can be distributed and used with

installations of BPA Platform.

Who Should Use it?

The Tool SDK is intended for use by anyone with a basic understanding of BPA Platform and programming in either

Microsoft Visual Basic or Microsoft Visual C#.

What do I Need to Use it?

To use tools generated with the Tool SDK, each copy of BPA Platformmust have the Tool Interface API installed and

licensed to use the required number of plug-in tools. Codeless Platforms Sales will be able to supply the keys

required to activate your software for this feature.

To create tools for use with BPA Platform, you need a supported copy of Microsoft Visual Studio, a copy of Codeless

Platforms BPA Platform, and a copy of the BPA Platform Tool SDK.
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What are theDifferent Types of Tool I can Createwith it?

 Input— Input tools extract information from a source, such as a database, internet web service, or barcode

reader, andmake it available to other tools in BPA Platform

 Output—Output tools accept information in the form of documents or recordsets and perform a task on this

data. This may be distributing it by a transport such as SMS or email, or storing it to a database or file for later

use

 Format— Format tools accept information usually in the form of a recordset, perform some processing on it

(for example conversion to HMTL or PDF) andmake the outputted document or recordset available to other

tools to use

 General—General tools either accept or generate information in the form of recordsets or documents. An

example might be a word counter where the configuration allows dynamic text to be entered with a list of

words to check for. This would then be published as a step parameter.

 Integration— "Templated" integration tools can be generated that call onto specific third-party APIs. These

tools consume XML containing the details of the data that you want to change in the third-party application

and output XML for consumption in other BPA Platform tools.

Howdo I Distributemy Tools?

The Tool SDKWizard automatically creates a setup project. You add the new tool to this and build it. This then

generates a setup.exe installer file which can be distributed as required.
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About the Workflow Web Service

The WorkflowWeb Service is a .NET-enabled software application that enables developers to integrate functionality

for users to add, edit, submit, re-assign, and delete Workflow Jobs into their own web sites, applications, or web

services.

As the product is .NET enabled and access to the web service uses standard internet protocols, it is vendor, platform

and language independent enabling multiple methods of connection. The web service also supports WSDL and

DISCO.

For details of the functions, objects, and so on included in the web service, request our Workflow Web Service —

Programming Specifics document from your account manager or business partner.
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Want to learn more?

Discover how Codeless Platforms can help your business by improving 
performance, boosting efficiency and cutting costs.

+44 (0) 330 99 88 700

enquiries@codelessplatforms.com

www.codelessplatforms.com
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